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Copyright © 2022 ZKTECO CO., LTD. All rights reserved. 

Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any 
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or 
"ZKTeco"). 

Trademark 

  is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned by 
their respective owners. 

Disclaimer 

This manual contains information on the operation and maintenance of the ZKTeco equipment. The 

copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is 

the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third 

party without express written permission of ZKTeco. 

The contents of this manual must be read as a whole before starting the operation and maintenance of the 
supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please contact 
ZKTeco before starting the operation and maintenance of the said equipment.  

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and 

maintenance personnel are fully familiar with the design and that the said personnel have received 

thorough training in operating and maintaining the machine/unit/equipment. It is further essential for the 

safe operation of the machine/unit/equipment that personnel has read, understood and followed the 

safety instructions contained in the manual. 

In case of any conflict between terms and conditions of this manual and the contract specifications, 

drawings, instruction sheets or any other contract-related documents, the contract conditions/documents 

shall prevail. The contract specific conditions/documents shall apply in priority. 

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information 

contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty 

of any kind, including, without limitation, any warranty of design, merchantability or fitness for a particular 

purpose. 

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which 

are referenced by or linked to this manual. The entire risk as to the results and performance obtained from 

using the information is assumed by the user. 

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect, 

special, or exemplary damages, including, without limitation, loss of business, loss of profits, business 

interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or 
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relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been 

advised of the possibility of such damages.  

This manual and the information contained therein may include technical, other inaccuracies or 

typographical errors. ZKTeco periodically changes the information herein which will be incorporated into 

new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the 

information contained in the manual from time to time in the form of circulars, letters, notes, etc. for better 

operation and safety of the machine/unit/equipment. The said additions or amendments are meant for 

improvement /better operations of the machine/unit/equipment and such amendments shall not give any 

right to claim any compensation or damages under any circumstances. 

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any 

non-compliance of the instructions contained in this manual (ii) in case of operation of the 

machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in 

conditions different from the prescribed conditions of the manual. 

The product will be updated from time to time without prior notice. The latest operation procedures 
and relevant documents are available on http://www.zkteco.eu. 

If there is any issue related to the product, please contact us. 

ZKTeco Europe 

Address Ctra. Fuencarral 44. Building 1, 2nd Floor. 

28108 Alcobendas Madrid. Spain

For business related queries, please write to us at: sales@zkteco.eu. 

To know more about our global branches, visit www.zkteco.eu.  

mailto:sales@zkteco.com
http://www.zkteco.com/
http://www.zkteco.eu
sales@zkteco.eu
www.zkteco.eu
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About the Company 

ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein) 

readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition 

Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and 

Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security 

solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art 

700,000 square foot ISO9001-certified manufacturing facility, we control manufacturing, product design, 

component assembly, and logistics/shipping, all under one roof. 

The founders of ZKTeco have been determined for independent research and development of biometric 

verification procedures and the productization of biometric verification SDK, which was initially widely 

applied in PC security and identity authentication fields. With the continuous enhancement of the 

development and plenty of market applications, the team has gradually constructed an identity 

authentication ecosystem and smart security ecosystem, which are based on biometric verification 

techniques.  With years of experience in the industrialization of biometric verifications, ZKTeco was 

officially established in 2007 and now has been one of the globally leading enterprises in the biometric 

verification industry owning various patents and being selected as the National High-tech Enterprise for 6 

consecutive years. Its products are protected by intellectual property rights. 

About the Manual 

This manual introduces the operations of EFace10.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly consistent 

with the actual products. 

Features and parameters with ★ are not available in all devices. 
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Document Conventions 

Conventions used in this manual are listed below: 

GUI Conventions 

For Software 

Convention Description 

Bold font Used to identify software interface names e.g., OK, Confirm, Cancel. 

> 
Multi-level menus are separated by these brackets. For example, File > Create > 
Folder. 

For Device 

Convention Description 

< > Button or key names for devices. For example, press <OK>. 

[ ] 
Window names, menu items, data table, and field names are inside square 
brackets. For example, pop up the [New User] window. 

/ 
Multi-level menus are separated by forwarding slashes. For example, 
[File/Create/Folder]. 

Symbols 

Convention Description 

This represents a note that needs to pay more attention to. 

The general information which helps in performing the operations faster. 

The information which is significant. 

Care taken to avoid danger or mistakes. 

The statement or event that warns of something or that serves as a cautionary 
example. 
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Safety Measures 

The below instructions intend to ensure that the user can use the product correctly to avoid danger or 

property loss. The following precautions are to keep the user’s safety and prevent any damage. Please read 

carefully before installation. 

1. Read, follow, and retain instructions - All safety and operational instructions must be properly
read and followed before bringing the device into service.

2. Do not ignore warnings - Adhere to all warnings on the unit and in the operating instructions.

3. Accessories - Use only manufacturer-recommended or product-sold accessories. Please do not
use any other components other than manufacturer suggested materials.

4. Precautions for the installation – Do not place this device on an unstable stand or frame. It may
fall and cause serious injury to persons and damage to the device.

5. Service - Do not try to service this unit yourself. Opening or removing covers may expose you to
hazardous voltages or other hazards.

6. Damage requiring service - Disconnect the system from the main AC or DC power source and
refer service personnel under the following conditions:

 When cord or connection control is affected.

 When any liquid is spilled, or an item dropped into the system.

 If exposed to water and/or an inclement weather (rain, snow, and more).

 If the system is not operating normally under operating instructions.

Just change controls defined in operating instructions. Improper adjustment of the controls may 

result in damage and involve a qualified technician to return the device to normal operation. 

7. Replacement parts - When replacement parts are needed, service technicians must only use
replacement parts provided by the supplier. Unauthorized substitutes can result in a burn, shock,

or other hazards.

8. Safety check - On completion of service or repair work on the unit, ask the service technician to
perform safety checks to ensure proper operation of the unit.

9. Power sources - Operate the system only from the label's power source form. If the sort of power
supply to use is unclear, call your dealer.

10. Lightning - External lightning conductors can be installed to protect against electrical storms. It
stops power-ups from destroying the system.

NOTE: The devices should be installed in areas with limited access. 
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1 Instruction for Use 

Before getting into the device features and its functions, it is recommended to be familiar to the below 

fundamentals. 

 Standing Position, Facial Expression and Standing Posture 1.1

 The recommended distance 

 

 Recommended Standing Posture and Facial Expression 

 
Standing Posture           Facial Expression 

NOTE: During enrolment and verification, please maintain natural facial expression and standing posture. 

It is recommended to have a 0.5m space 

between the device and the user whose height 

is in a range of 1.55m to 1.85m. Users may 

slightly move forwards or backward to improve 

the character recognition of facial images 
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 Face Registration 1.2
Try to keep the face in the centre of the screen during registration. Please face towards the camera and 

stay still during face registration. The screen should look like this: 

Correct face registration and authentication method 

 Recommendation for registering a face

 When registering a face, maintain a distance of 40cm to 80cm between the device and the

face.

 Be careful to keep your facial expression natural and not to change. (smiling, drawn face, wink,

etc.)

 If you do not follow the instructions on the screen, the face registration may take longer or

may fail.

 Be careful not to cover the eyes or eyebrows.

 Do not wear hats, masks, sunglasses, or eyeglasses.

 Be careful not to display two faces on the screen. Register one person at a time.

 It is recommended for a user wearing glasses to register both faces with and without glasses.

 Recommendation for authenticating a face

 Ensure that the face appears inside the guideline displayed on the screen of the device.

 Sometimes, authentication may fail due to the change in the wearing glasses then the one

used while registration. In such a case, you may require authenticating your face with the

previously worn glasses. If your face was registered without glasses, you should authenticate

your face without glasses further.

 If a part of the face is covered with a hat, a mask, an eye patch, or sunglasses, authentication

may fail. Do not cover the face, allow the device to recognize both the eyebrows and the

face.
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 Standby Interface 1.3
After connecting the power supply, the following standby interface is displayed: 

 Click  to enter the User ID input interface. 

 When there is no Super Administrator set in the device, tap  to go to the menu. 

 After adding a Super Administrator on the device, it requires the Super Administrator’s verification

before entering the menu functions.

NOTE: For the security of the device, it is recommended to register super administrator the first

time you use the device.

 ★The punch state options can also be displayed and used directly on the standby interface. Tap

anywhere on the screen apart from the icons, and six shortcut keys appears on the screen, as

shown in the figure below:

 Press the corresponding punch state key to select your current punch state, which is displayed in

green.

NOTE: The punch state options are off by default and need to be changed to other option. Refer 7.4 Punch 

States Options in order to get the punch state options on the standby screen. 
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 Virtual Keyboard 1.4

NOTE: 

The device supports the input in Chinese language, English language, numbers, and symbols. 

 Click [En] to switch to the English keyboard.

 Press [123] to switch to the numeric and symbolic keyboard.

 Tap [ABC] to return to the alphabetic keyboard.

 Tap the input box, virtual keyboard appears.

 Tap [ESC] to exit the virtual keyboard.

 Verification Mode 1.5

1.5.1 Facial Verification 

 1:N Facial Verification

In this verification mode, the device compares the collected facial images with all face data registered in 

the device. The following is the pop-up prompt of a successful comparison result. 
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 1:1 Facial Verification

In this verification mode, the device compares the face captured by the camera with the facial template 

related to the entered user ID. Press            on the main interface and enter the 1:1 facial verification mode 

and enter the user ID and tap [OK]. 

If the user has registered password and card in addition to his/her face, and the verification method is set 

to password/face/card verification, the following screen will appear. Select the       icon to enter the face 

verification mode. 

After successful verification, the prompt box displays "Successfully verified", as shown below: 

If the verification is failed, it prompts "Please adjust your position!". 
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1.5.2 Card Verification★ 

 1:N Card Verification  

The 1: N Card Verification mode compares the card number in the card induction area with all the card 

number data registered in the device; The following is the card verification screen. 

 

 1:1 Card Verification  

The 1:1 Card Verification mode compares the card number in the card induction area with the number 

associated with the employee's User ID registered in the device. 

Press  in the main interface to open the 1:1 card verification mode.  

Enter the user ID and tap [OK].  

 

If the user has registered password and face in addition to his/her card, and the verification method is set 

to password/face/card verification, the following screen will appear. Select the          icon to enter the card 

verification mode. 
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After successful verification, the prompt box displays "Successfully verified", as shown below:  

 

1.5.3 Password Verification 

The device compares the entered password with the registered password by the given User ID.  

Click the            button on the main screen to enter the 1:1 password verification mode. Then, input the user 

ID and press [OK]. 

 

If the user has registered face and card in addition to password, and the verification method is set to 

password/face/card verification, the following screen will appear. Select the      icon to enter password 

verification mode.  

 

Input the password and press [OK]. 
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Following are the display screen after entering a correct password and a wrong password respectively. 

Verification is successful:     Verification is failed: 

      

1.5.4 Combined Verification  

For increased security and accessibility, the device offers the option of using multiple forms of verification 

methods. A total of 9 different verification combinations can be used, as shown below:  

Combined Verification Symbol Definition 

Symbol Definition Explanation 

/ or This method compares the entered verification of a person with the related 
verification template previously stored to that Personnel ID in the Device. 

+ and This method compares the entered verification of a person with all the verification 
template previously stored to that Personnel ID in the Device. 
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Procedure to set for Combined Verification Mode 

 Combined verification requires personnel to register all the different verification method. 
Otherwise, employees will not be able to successfully verify through the combined verification 
process. 

 For instance, when an employee has registered only the face data, but the device verification 
mode is set as "Face + Password", the employee will not be able to complete the verification 
process successfully. 

 This is because the device compares the scanned face template of the person with registered 

verification template (both the Face and the Password) previously stored to that Personnel ID in 

the Device. 

 But as the employee has registered only the Face but not the Password, the verification will not 

get completed and the Device displays "Verification Failed". 
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2 Main Menu 

Press            on the Standby interface to enter the Main Menu, the following screen will be displayed:  

      

Function Description 

Menu  Descriptions 

User Mgt. To Add, Edit, View, and Delete basic information of a User. 

User Role 
To set the permission scope of the custom role and enroller for the users, that is, 
the rights to operate the system. 

COMM. 
To set the relevant parameters of Ethernet, PC Connection, Wireless Network, 
Cloud Server Setting, and Network Diagnosis. 

System 
To set the parameters related to the system, including Date Time, Attendance, 
Face Parameter, Reset to factory and USB Upgrade. 

Personalize 
To customize settings of User Interface, Voice, Bell Schedules, Punch State 
Options, and Shortcut Key Mappings settings.  

Data Mgt. To delete all relevant data in the device. 

Department★ 
Establish the organizational structure of the department, including functions like 
adding, editing, or deleting the department, and scheduling the department, etc. 

Shift set★ 
Set attendance rules and the number of shifts to be used, and schedule 
employees. The device supports up to 24 shifts. 

Report★ 

Use USB flash drive to download the attendance statistics form to check on the 
computer or download the attendance settings form to set shifts on the 
computer, assign shifts to employees and then upload the attendance settings 
form. At this time, the device will give priority to the use of the schedule of the 
settings form. 

Access Control To set the parameters of the lock. 

USB Manager To upload or download the specific data by a USB drive. 
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Attendance Search 
To query the specified Attendance Record, check Attendance Photo, and Blocklist 
ATT Photo. 

Work Code Set different type of work. 

Autotest 
To automatically test whether each module functions properly, including the LCD 
Screen, Audio, Camera, and real-time clock. 

System Info 
To view Data Capacity and Device and Firmware information of the current 
device. 
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3 User Management 

 User Registration 3.1
Click User Mgt. on the main menu. 

 

3.1.1 User ID and Name 

Tap New User. Enter the User ID and Name. 

      

Notes:  

1） A name can take up to 36 characters. 

2） The user ID may contain 1-9 digits by default. 

3） During the initial registration, you can modify your ID, which can’t be modified after registration. 

4） If a message "Duplicated!" pops up, you must choose another ID as the enter User ID already 

exists. 
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3.1.2 User Role 

On the New User interface, tap User Role to set the role for the user as either Normal User or Super 
Admin. 

 Super Admin: The Super Administrator owns all management privileges in the device. 

 Normal User: If the Super Admin is registered already in the device, then the Normal Users will not 

have the privilege to manage the system and can only access authentication verifications. 

 User Defined Roles: The Normal User can also be assigned custom roles with User Defined Role. 
The user can be permitted to access several menu options as required. 

 

NOTE: If the selected user role is the Super Admin, the user must pass the identity authentication to access 

the main menu. The authentication is based on the authentication method(s) that the super administrator 

has registered. Please refer to1.5 Verification Mode. 

3.1.3 Department★ 

There are 8 default departments of the equipment, namely "Company", "Executive Dept.", "Sales", 

"Financial Dept.", "Production", "Purchasing Dept.", "Custom 1", "Custom 2". Refer to section 9 Department 

Management. 

Select the Department to enter the department selection interface. 
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3.1.4 Face 

Tap Face in the New User interface to enter the face registration page. 

 Please face towards the camera and position yourself such that your face image fits inside the 

white guiding box and stay still during face registration. 

 A progress bar shows up while registering the face and a "Enrolled Successfully" message is 

displayed as the progress bar completes. 

 If the face is registered already then, the "Duplicate Face" message shows up. The registration 

interface is as follows:  

 

3.1.5 Card★ 

Tap Card in the New User interface to enter the card registration page.  

 On the Card interface, swipe the card underneath the card reading area. The card registration will 

be successful. 

 If the card is registered already then, the "Duplicate Card" message shows up. The registration 

interface is as follows: 

 

3.1.6 Password 

Tap Password in the New User interface to enter the password registration page.  

 On the Password interface, enter the required password and re-enter to confirm it and tap OK. 
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 If the re-entered password is different from the initially entered password, then the device 

prompts the message as "Password not match!", where the user needs to confirm the password 

again. 

 

NOTE: The password may contain 1 to 8 digits by default. 

3.1.7 Profile Photo 

Tap on Profile Photo in the New User interface to go to the Profile Photo registration page. 

      

 When a user registered with a photo authenticates successfully, the registered photo is displayed. 

 Tap Profile Photo to open the device’s camera, then tap the camera icon to take a photo. The 

captured photo is displayed on the top left corner of the screen and the camera opens up again to 

take a new photo, after taking the initial photo.  

NOTE: While registering a face, the system automatically captures a photo as the profile photo. If you do 

not register a profile photo, the system automatically sets the photo captured while registration as the 

default photo.  

 Search User 3.2
On the Main Menu, tap User Mgt., and then tap All Users to search for a User. 

 On the All Users interface, tap on the search bar on the user’s list to enter the required retrieval 
keyword (where the keyword may be the user ID, surname, or full name) and the system will search 
for the related user information. 
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 Edit User 3.3
On the All Users interface, tap on the required user from the list and tap Edit to edit the user information. 

         

NOTE: The process of editing the user information is the same as adding a new user, except that the User 

ID cannot be modified when editing a user. The process in detail refers to 3 User Management. 

 Delete User 3.4
On the All Users interface, tap on the required user from the list and tap Delete to delete the user or a 
specific user information from the device. On the Delete interface, tap on the required operation and then 
tap OK to confirm the deletion. 

Delete Operations 

Delete User: Deletes all the user information (deletes the selected User as a whole) from the device. 

Delete Face Only: Deletes the face information of the selected user. 

Delete Password Only: Deletes the password information of the selected user. 

Delete User Photo Only: Deletes the photo of the selected user. 
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 Display Style 3.5
On the Main Menu, tap User Mgt., and then tap Display Style to enter Display Style setting interface. 

 

All the Display Styles are shown as below: 

                

Single Line Style                                                                         Multiple Line Style 

 

Mixed Line Style 
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4 User Role 

User Role facilitates assigning some specific permissions to certain users based on the requirement. 

 On the Main menu, tap User Role > User Defined Role to set the user defined permissions. 

 A total of 3 different custom roles can be added. It is the custom operating scope of a user. 

 

 On the User Defined Role interface, toggle Enable Defined Role to enable or disable the user 
defined role. 

 Tap on Name and enter the custom name of the role. 

 

 Then, tap on Define User Role and select the required privileges to assign to the new role, and 
then tap on the Return button. 

 During privilege assignment, the Main Menu function names are displayed on the left and its sub-
menus are listed on its right. 

 First, tap on the required Main Menu function name, and then select its required sub-menus from 
the list which the user can access. 

         

NOTE: If the User Role is enabled for the device, tap on User Mgt. > New User > User Role to assign the 
created roles to the required users. But if there is no super administrator registered in the device, then the 
device will prompt "Please enroll super admin first!" when enabling the User Role function. 
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5 Communication Settings 

Tap COMM. on the Main Menu to set the relevant parameters of Ethernet, PC Connection, Wireless 

Network, Cloud Server, and Network Diagnosis. 

 

 Ethernet Settings 5.1
When the device needs to communicate with a PC over the Ethernet, you need to configure network 

settings and ensure that the device and the PC are connect to the same network segment.  

Tap Ethernet on the Comm. Settings interface to configure the settings.  

      

Function Description 

Function Name Descriptions 

IP Address 
The default IP address is 192.168.1.201. It can be modified according to the 
network availability. 

Subnet Mask 
The default Subnet Mask is 255.255.255.0. It can be modified according to the 
network availability. 

Gateway 
The default Gateway address is 0.0.0.0. It can be modified according to the 
network availability. 

DNS 
The default DNS address is 0.0.0.0. It can be modified according to the 
network availability. 
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TCP COMM. Port 
The default TCP COMM Port value is 4370. It can be modified according to the 
network availability. 

DHCP 
It stands for Dynamic Host Configuration Protocol. It dynamically allocates IP 
addresses for clients via server. 

Display in Status Bar Toggle to set whether to display the network icon on the status bar. 

 PC Connection 5.2
Comm Key facilitates to improve the security of data by setting the communication between the device 

and the PC. Once the Comm Key is set, a connection password is required to connect the device to the PC 

software.  

Tap PC Connection on the Comm. settings interface to configure the communication settings.  

 

Function Description 

Function Name Descriptions 

Comm Key 
The default password is 0 and can be changed later. 

The Comm Key can contain1-6 digits. 

Device ID It is the identification number of the device, which ranges between 1 and 254. 

 

 Wireless Network 5.3
 The device provides a Wi-Fi module, which can be built-in within the device module or can be externally 

connected. 

The Wi-Fi module enables data transmission via Wi-Fi (Wireless Fidelity) and establishes a wireless network 

environment. Wi-Fi is enabled by default in the device. If you don't need to use the Wi-Fi network, you can 

toggle the Wi-Fi to disable the button. 

Tap Wireless Network on the Comm. settings interface to configure the Wi-Fi settings. 
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Search the WIFI Network 

 WIFI is enabled in the device by default. Toggle the    button to enable or disable WIFI. 

 Once the Wi-Fi is turned on, the device searches for the available WIFI within the network range. 

 Tap on the required Wi-Fi name from the available list and input the correct password in the 

password interface, and then tap Connect to WIFI (OK). 

  

WIFI Enabled: Tap on the required network from 
the searched network list. 

      

Tap on the password field to enter the password, 
and then tap on Connect to WIFI (OK). 

 When the WIFI is connected successfully, the initial interface will display the Wi-Fi  logo. 

Add WIFI Network Manually 

The Wi-Fi can also be added manually if the required Wi-Fi does not show on the list. 

 

Tap on Add WIFI Network to add the WIFI 
manually. 

      

On this interface, enter the WIFI network 
parameters. (the added network must exist.) 

NOTE: After successfully adding the WIFI manually, follow the same process to search for the added WIFI 

name. Click here to view the process to search the WIFI network. 
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Advanced Setting 

On the Wireless Network interface, tap on Advanced to set the relevant parameters as required. 

      

Function Description 

Function Name  Description 

DHCP 
Dynamic Host Configuration Protocol (DHCP) dynamically allocates IP addresses 
to network clients. If the DHCP is enabled, then the IP cannot be set manually. 

IP Address 
The IP address for the WIFI network, the default is 0.0.0.0. It can be modified 
according to the network availability. 

Subnet Mask 
The default Subnet Mask of the WIFI network is 255.255.255.0. It can be modified 
according to the network availability. 

Gateway  
The default Gateway address is 0.0.0.0. It can be modified according to the 
network availability. 

 Cloud Server Setting 5.4
Tap Cloud Server Setting on the Comm. settings interface to connect with the ADMS server. 
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Function Description 

Function Name Description 

Enable 
Domain 
Name 

Server Address 
Once this function is turned ON, the domain name mode "http://..." 
will be used, such as http://www.XYZ.com, while "XYZ" denotes the 
domain name. 

Disable 
Domain 
Name 

Server Address The IP address of the ADMS server. 

Server Port Port used by the ADMS server. 

Enable Proxy Server 
The IP address and the port number of the proxy server is set 
manually when the proxy is enabled. 

HTTPS 
Based on HTTP, transmission encryption and identity 
authentication ensure the security of the transmission process. 

 Network Diagnosis 5.5
It helps to set the network diagnosis parameters. 

Tap Network Diagnosis on the Comm. settings interface. Enter the IP address that needs to be diagnosed 

and tap Start the diagnostic test to check whether the network can connect to the device. 
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6 System Settings 

It helps to set related system parameters to optimize the accessibility of the device.  

Tap System on the Main Menu interface to get to its menu options.  

 

 Date Time 6.1
Tap Date Time on the System interface to set the date and time.  

 

 Tap Manual Date and Time to manually set date and time and tap Confirm to save.  

 Tap 24-Hour Time to enable or disable this format. If enabled, then select the Date Format to set 

the date format i.e., the way date should be displayed on the device. 

 Tap Daylight Saving Time to enable or disable the function. If enabled, tap Daylight Saving 

Mode to select a daylight-saving mode and then tap Daylight Saving Setup to set the switch 

time. 

Week Mode Date Mode 



EFace10                                                                  User Manual 

P a g e  | 33   Copyright©2022 ZKTECO CO., LTD.  All rights reserved. 

 When restoring the factory settings, the time (24-hour) and date format (YYYY-MM-DD) can be 

restored, but the device date and time cannot be restored.  

NOTE: For example, the user sets the time of the device (18:35 on March 15, 2019) to 18:30 on January 1, 

2020. After restoring the factory settings, the time of the equipment will remain 18:30 on January 1, 2020. 

 Attendance 6.2
Click Attendance on the System interface. 

      

Function Description 

Function Name Description 

Duplicate Punch 
Period(m) 

Within a set time period (unit: minutes), the duplicated attendance record will 
not be reserved (value ranges from 1 to 999999 minutes). 

Camera Mode 

Choose whether to capture and save the current snapshot image during 
verification. There are 5 modes:  

No Photo: No photo is taken during user verification. 

Take photo, no save: Photo is taken but not saved during verification. 

Take photo and save: Photo is taken and saved during verification. 

Save on successful verification: Photo is taken and saved for each successful 
verification.   

Save on failed verification: Photo is taken and saved only for each failed 
verification. 

Display User Photo 
Choose whether to display the user photo when the user passes the 
verification. 

Attendance Log Alert 

When the record space of the attendance reaches the maximum threshold 
value, the device automatically displays the memory space warning. 

Users may disable the function or set a valid value between 1 and 9999. 
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Periodic Del of ATT 
Data 

When attendance records reach its maximum storage capacity, the device 
automatically deletes a set of old attendance records. 

Users may disable the function or set a valid value between 1 and 999. 

Periodic Del of ATT 
Photo 

When attendance photos reach its maximum storage capacity, the device 
automatically deletes a set of old attendance photos. 

Users may disable the function or set a valid value between 1 and 99. 

Periodic Del of 
Blocklist Photo 

When block listed photos reach its maximum storage capacity, the device 
automatically deletes a set of old block listed photos.  

Users may disable the function or set a valid value between 1 and 99. 

Authentication 
Timeout(s) 

The amount of time taken to display a successful verification message. 

Valid value: 1~9 seconds. 

Face comparison 
interval (s) 

The amount of time required to compare facial templates. 

Valid value: 0~9 seconds. 

 Face Parameters 6.3
Tap Face on the System interface to go to the face parameter settings.  
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Function Description 

Function Name Description 

1:N Threshold Value 

Under 1:N verification mode, the verification will only be successful when the 
similarity between the acquired facial image and all registered facial templates 
is greater than the set value. 

The valid value ranges from 0 to 100. The higher the thresholds, the lower the 
misjudgement rate and the higher the rejection rate, and vice versa. It is 
recommended to set the default value of 47. 

1:1 Threshold Value 

Under 1:1 verification mode, the verification will only be successful when the 
similarity between the acquired facial image and the user’s facial templates 
enrolled in the device is greater than the set value. 

The valid value ranges from 0 to 100. The higher the thresholds, the lower the 
misjudgement rate and the higher the rejection rate, and vice versa. It is 
recommended to set the default value of 63. 

Face 
Enrollment Threshold 

During face enrollment, 1:N comparison is used to determine whether the user 
has already registered before.  

When the similarity between the acquired facial image and all registered facial 
templates is greater than the set threshold, it indicates that the face has already 
been registered. 

Face Pitch Angle  

It is the pitch angle tolerance of a face for facial template registration and 
comparison. 

If a face’s pitch angle exceeds the set value, it will be filtered by the algorithm, 
i.e., ignored by the terminal thus no registration and comparison interface will 
be triggered. 

Face Rotation Angle  

It is the rotation angle tolerance of a face for facial template registration and 
comparison.  

If a face’s rotation angle exceeds the set value, it will be filtered by the 
algorithm, i.e., ignored by the terminal thus no registration and comparison 
interface will be triggered. 

Image Quality 
It is the image quality for facial registration and comparison. The higher the 
value, the clearer image is required. 
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Minimum Face Size 

It sets the minimum face size required for facial registration and comparison.  

If the minimum size of the captured image is smaller than the set value, then it 
will be filtered off and not recognized as a face.  

This value can also be interpreted as the face comparison distance. The farther 
the individual is, the smaller the face, and the smaller number of pixels of the 
face obtained by the algorithm. Therefore, adjusting this parameter can adjust 
the farthest comparison distance of faces. When the value is 0, the face 
comparison distance is not limited. 

LED Light Triggered 
Value 

This value controls the turning on and off of the LED light. The larger the value, 
the LED light will turn on or off more frequently. 

Motion Detection 
Sensitivity 

It sets the value for the amount of change in a camera’s field of view known as 
potential motion detection that wakes up the terminal from standby to the 
comparison interface. 

The larger the value, the more sensitive the system would be, i.e., if a larger 
value is set, the comparison interface activates with much ease, and the motion 
detection is frequently triggered. 

Live Detection  
It detects the spoof attempt using visible light images to determine if the 
provided biometric source sample is of a real person (a live human being) or a 
false representation. 

Live Detection 
Threshold 

It facilitates judging whether the captured visible image is a real person (a live 
human being). The larger the value, the better the anti-spoofing performance 
using visible light. 

Anti-spoofing using 
NIR 

It uses near-infrared spectra imaging to identify and prevent fake photos and 
videos attack. 

Face Algorithm It has facial algorithm related information and pause facial template update. 

NOTE: Improper adjustment of the exposure and quality parameters may severely affect the performance 

of the device. Please adjust the exposure parameter only under the guidance of the after-sales service 

personnel of our company. 
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 Factory Reset 6.4
The Factory Reset function restores the device settings such as communication settings and system 

settings, to the default factory settings (this function does not clear registered user data). 

Tap Reset on the System interface and then tap OK to restore the default factory settings. 

 

 USB Upgrade 6.5
With this option, the device firmware can be upgraded by using the upgrade file on a USB disk. Before 

conducting this operation, ensure that the USB disk is properly inserted into the device and contains the 

correct upgrade file.  

If no USB disk is plugged in, the system gives the following prompt after you tap USB Upgrade on the 

System interface.  

 

NOTE: If an upgrade file is required, please contact our technical support. A firmware upgrade is not 

recommenced under normal circumstances. 
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7 Personalize Settings  

Tap Personalize on the Main Menu interface to customize interface settings, voice, bell, punch state 

options, and shortcut key mappings. 

 

 Interface Settings 7.1
Tap User Interface on the Personalize interface to customize the display style of the main interface. 

       

Function Description 

Function Name Description 

Wallpaper It helps to select the main screen wallpaper according to the user preference. 

Language It helps to select the language of the device. 

Menu Screen 
Timeout (s) 

When there is no operation, and the time exceeds the set value, the device 
automatically goes back to the initial interface. 

The function can either be disabled or set the required value between 60 and 
99999 seconds. 

Idle Time To Slide 
Show (s) 

When there is no operation, and the time exceeds the set value, a slide show is 
displayed. The function can be disabled, or you may set the value between 3 
and 999 seconds. 
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Slide Show  

Interval (s) 

It is the time interval in switching between different slide show pictures. The 
function can be disabled, or you may set the interval between 3 and 999 
seconds. 

Idle Time to Sleep 
(m) 

If the sleep mode is activated, and when there is no operation in the device, 
then the device will enter standby mode. 

This function can be disabled or set a value within 1-999 minutes.  

Main Screen Style It helps selecting the main screen style according to the user preference. 

 Voice Settings 7.2
Tap Voice on the Personalize interface to configure the voice settings.  

 

Function Description 

Function Name Description 

Voice Prompt Toggle to enable or disable the voice prompts during function operations. 

Touch Prompt Toggle to enable or disable the keypad sounds. 

Volume Adjust the volume of the device which can be set between 0-100. 

 Bell Schedules 7.3
Tap Bell Schedules on the Personalize interface to configure the Bell settings. 
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New Bell Schedule 

Tap New Bell Schedule on the Bell Schedule interface to add a new bell schedule. 

 

Function Description 

Function Name Description 

Bell Status Toggle to enable or disable the bell status.  

Bell Time 
Once the required time is set, the device will automatically trigger to ring the bell 
during that time. 

Repeat Set the required number of counts to repeat the scheduled bell. 

Ring Tone Select a ring tone. 

Internal bell delay(s) 
Set the replay time of the internal bell. Valid values ranges from 1 to 999 
seconds. 

All Bell Schedules 

Once the bell is scheduled, on the Bell Schedules interface, tap All Bell Schedules to view the newly 

scheduled bell. 
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Edit the scheduled bell 

On the All Bell Schedules interface, tap on the required bell schedule, and tap Edit to edit the selected 

bell schedule. The editing method is the same as the operations of adding a new bell schedule. 

      

Delete a bell 

On the All Bell Schedules interface, tap the required bell schedule, and tap Delete, and then tap Yes to 

delete the selected bell. 

      

 Punch States Options 7.4
Tap Punch States Options on the Personalize interface to configure the punch state settings. 
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Function Description 

Function Name Description 

Punch State Mode 

 

Off: It disables the punch state function. And the punch state key set under 
the Shortcut Key Mappings menu becomes invalid. 

Manual Mode: Switch the punch state key manually, and the punch state key 
will disappear after Punch State Timeout. 

Auto Mode: The punch state key will automatically switch to a specific punch 
status according to the predefined schedule which can be set in the Shortcut 
Key Mappings. 

Manual and Auto Mode: The main interface will display the auto-switch 
punch state key. However, the users will still be able to select an alternative 
that is the manual attendance status. After timeout, the manual switching 
punch state key will become auto-switch punch state key. 

Manual Fixed Mode: After the punch state key is set manually to a particular 
punch status, the function will remain unchanged until being manually 
switched again. 

Fixed Mode: Only the manually fixed punch state key is shown. Users cannot 
change the status by pressing any other keys. 

 Shortcut Key Mappings 7.5

Users may define shortcut keys for attendance status and functional keys on the main interface. So, on the 

main interface, when the shortcut keys are pressed, the corresponding attendance status or the function 

interface displays directly. 

Tap Shortcut Key Mappings on the Personalize interface to set the required shortcut keys. 

 

 On the Shortcut Key Mappings interface, tap on the required shortcut key to configure the 

shortcut key settings. 

 On the Shortcut Key (that is "Up Key") interface, tap function to set the functional process of the 

shortcut key either as punch state key or function key. 

 If the Shortcut key is defined as a function key (such as New user, All users, etc.), the configuration 

is done as shown in the image below. 
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 If the Shortcut key is set as a punch state key (such as check in, check out, etc.), then it is required 

to set the punch state value (valid value 0~250), name. 

NOTE: When the function is set to Undefined, the device will not enable the punch state key. 
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8 Data Management 

On the Main Menu, tap Data Mgt. to delete the relevant data in the device. 

 

 Delete Data 8.1
Tap Delete Data on the Data Mgt. interface to delete the required data.  

      

Function Description 

Function Name Description 

Delete Attendance Data To delete attendance records conditionally. 

Delete Attendance Photo To delete attendance photos of designated personnel. 

Delete Blocklist Photo To delete the photos taken during failed verifications. 

Delete All Data To delete information and attendance records of all registered users. 

Delete Admin Role To remove all administrator privileges.  

Delete Profile Photo To delete all profile photos in the device. 

Delete Wallpaper To delete all wallpapers in the device. 

Delete Screen Savers To delete the screen savers in the device. 
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NOTE: The user may select Delete All or Delete by Time Range when deleting the attendance records, 

attendance photos, or block listed photos. When selecting Delete by Time Range, you need to set a time 

range to delete all data within the specified time. 

 

Select Delete by Time Range 

      

Set the time range and click OK. 
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9 Department Management★ 

Establishing an organizational structure of the company and arranging departments shift is necessary to 

view the department information of the device. In this menu option, you can add, edit, or remove a 

department. 

Select Department on the main menu interface.  

 

 Add a Department 9.1

1. Select Add Dept. to enter the Add Dept. interface. 

 

2. Select Dept. Name and enter the department name. 

 

3. Select the Dept. Shifting of the department.  
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Note:  

1. The equipment will automatically assign numbers to departments, starting from 1 and so on. 

2. Dept. Shift: Select the shift attendance used by all users of the department. Shifts can be set in Shift 
set > Shifts setting, with a maximum of 24 shifts set by default. Refer to Shift Set section. 

 Edit a Department 9.2

There are 8 departments in the device by default. You can edit the department name and department shift, 

but you cannot delete them. In addition to the 8 default departments, additional departments can be 

edited and deleted. 

 

1. Select Dept. Lists to enter Edit Dept. interface. 

 

2. Select a department to be edit. 

 

3. Modify the Dept. Name and Dept. Shifting. (Note: The editing of the department is the same as of 

Add Dept.) 
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 Delete a Department 9.3

It helps to remove one or more department as required. 

 

1. Select Dept. Lists to enter the Dept. Lists interface. 

 

2. Select a department to delete. 

 

3. Select Delete, and then tap Yes. 

Note: Only departments other than the 8 default departments in the device can be deleted.  
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10 Shift Set★ 

Set attendance rules, number of shifts to be used, and schedule employees. 

Select Shift Set option on the main menu interface. 

 

 Attendance Rule 10.1

All attendance statistics are conducted according to the attendance rules. Therefore, the staff attendance 

rules need to be set first, including late, early leave calculation method, and scheduling type. Once the 

attendance rules are set, it is not recommended to modify them frequently as it may affect the result of 

attendance calculation and may cause chaos in the scheduling if it is modified in the middle of the month. 

Select Attendance Rule on the Shift Set interface.   

 

Item Descriptions 

Count Late On-duty 
Set a time after which the lateness calculation for an employee should 
start. If it is disabled, the lateness calculation starts with the start of 
working hours. 

Count Leave Off-duty 
Set a time before which the early leave calculation for an employee should 
start. If disabled, it is calculated with respect to the end of the working 
hours. 

Schedule Type 
The device supports both department and individual-based scheduling. 

If a company uses one timetable, then only one department needs to be 
set and department-based scheduling is recommended. 
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If the departments have their respective timetables, department-based 
scheduling is recommended. 

If employees may take different shifts, individual-based scheduling is 
recommended. 

Default Shift 
When individual-based scheduling is used, the default shift applies to all 
the non-scheduled employees. 

SAT On-duty Enable whether to work normally on Saturdays. 

SUN On-duty Enable whether to work normally on Sundays. 

 Shift Setting 10.2

Select Shift Setting on the Shift Set interface. 

 

1. Select a Shift on the list. 

 

2. Enter the "Shift Name" and set the required start and end times. 

 

Note: The device supports a maximum of 24 shifts including two default shifts (Shift 1 and Shift 2). All the 

shifts are editable, and a single shift includes three-time ranges at most. 
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 Schedule 10.3

The shifts should be set based on the actual condition of a company. If no shift is set, the system makes 

attendance calculations based on default shifts set in attendance rules.  

Select Schedule on the Shift Set interface.  

 

 Department-based Scheduling 

Select Shift Set > Attendance Rule > Schedule Type > Dept. Shifting to schedule shift for a department. 

  

When a shift is selected for a department, it is implemented for all the members of the department. 

 Individual-based Scheduling 

Select Shift Set > Attendance Rule > Schedule Type > Personal Shift to schedule shift for an individual. 

1. Add Schedule 

1) Tap Shift Set to enter the Schedule interface, and select Add Personal Shift. 

 

2) Enter an ID. The device automatically displays the name. Select Shift Name. 
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2. Edit Schedule 

Enter the Personal Shift Lists for editing when the scheduling of individual employee needs to be 

adjusted. 

1) Select Personal Shift Lists on the Personal Shift interface. 

 

2) Select a scheduled user. 

 

3) Select Edit, enter and modify the "Shift Name" of the user. 

 

Note: The User ID cannot be modified. The other operations are the same as those performed to add a shift. 
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3. Delete a shift 

Go to the Personal Shift Lists, to delete an employee's schedule that is no longer required. 

1) Select Personal Shift Lists on the Personal Shift interface. 

 

2) Select a scheduled user. 

 

3) Select Delete and click "OK" to delete the Shift successfully. 
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11 Report★ 

This menu item allows you to download statistical reports of attendance or attendance setting reports to a 

USB flash drive or SD card. You can also upload attendance setting reports with defined shifts and 

employees' schedules. The device gives priority to the schedules in an attendance setting report. 

Select Report on the main menu interface. 

 

Note: First insert the USB flash drive into the USB slot of the machine, and then enter the main menu to 

perform the related operations of the Report.  

 Download Att. Report 11.1

1. Select Download Att. Report on the Report interface.   

 

2. Set the on-duty time and click Confirm (OK). 
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3. Set the off-duty time and click Confirm (OK). 

 

When Data download succeeds, Press [M/OK] to take out the USB disk. The SSRTemplateS.xls gets stored 

in the USB disk. The Schedule Information, Statistical Report of Attendance, Attendance Record Report, 

Exception Statistic Report, and Card Report can be viewed on a PC. The following reports show the 

preceding information: 

To make reports more understandable, a report containing two-day attendance records of four employees 

is provided as an example. 

 Schedule Information Report: The report allows you to view schedule records of all employees.  

 

 Statistical Report of Attendance: The report allows you to query the attendance of each person in a 

specified period. Salaries can be calculated directly based on this report.  

 

Note: The unit of Work hour and Overtime hour in the Statistical Report of Attendance is HH: MM. For 

example, 17:50 indicates that the on-duty time is 17 hours and 50 minutes. 

 Attendance Record Report: The report lists the daily attendance records of all employees within a 

specified period. 



EFace10                                                                  User Manual 

P a g e  | 56   Copyright©2022 ZKTECO CO., LTD.  All rights reserved. 

 

 Exception Statistic Report: The report displays the attendance exceptions of all employees within a 

specified period so that the attendance department handles the exceptions and confirm them with 

the employees involved and their supervisors.  

 

 Card Report: The report can substitute for clock-based cards and can be sent to each employee for 

confirmation. 

 

 Download Att. Setting Report 11.2

If shifts are complex or the shifts of a person are not fixed, it is recommended that the attendance setting 

report be downloaded and shifts and schedules be set for employees in the attendance setting report. 

Select Download Att. Setting Report on the Report interface. 
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Open the setting "AttSettingE.xls" in the USB disk on a PC. Set the Shift in the Attendance setting report. 

The shifts that have been set on the attendance machine shall be displayed. (For more details, see Shift 

Setting. You can modify the 24 shifts and add more shifts. After modification, the shifts shall prevail on the 

attendance machine. 

 

Set a schedule setting report 

Enter the ID, Name, and Department respectively on the left of the Schedule Setting Report. Set shifts 

for employees on the right of the Schedule Setting Report, where shifts 1–24 are shifts to set the 

Attendance Setting Report. Shift 25 is for leave and Shift 26 is for out. 

 

Notes:  

1. The shifts of only 31 days can be arranged in one schedule setting report. For example, if the 

scheduling date is 2022-1-1, the schedule setting report contains the schedules of 31 days after 2022-

1-1, that is, scheduled from 2022-1-1 to 2022-1-31. If the scheduling date is 2022-1-6, the schedule 

setting report contains the schedules of 31 days after 2022-1-6, that is, scheduled from 2022-1-6 to 

2022-2-5.  

2. If no schedule setting report is set, all employees use Report 1 by default from Monday to Friday. 

  

Enter the On-duty and Off-duty time in the 

corresponding columns, where the First time zone 

shall be the On-duty or Off-duty time of Time 1 of 

Shift Setting, and the Second time zone shall be 

the On-duty or Off-duty time of Time 2. 

For the correct schedule time format, see "What is 

the correct time format used in the setting reports" 

in the "Self-Service Attendance Terminal FAQs." 
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 Upload Att. Setting Report 11.3

After setting the attendance setting table, save the "Setting Report.xls" to the USB flash drive and reinsert 

the USB flash drive into the USB slot of the device. 

Select Upload Att. Setting Report on the Report interface. 

  

After uploading, remove the USB disk or SD card. At this time, the employee information, shift, and 

department in the setting report can be viewed respectively by the Management User, Shift Number, and 

Department available in the device. Or the above information and scheduling information can be seen in 

the standard download report. 

Note: If the schedule time format is incorrect, Re-upload the attendance setting report after modification. 

 Setting 11.4

Set whether to synchronize the card report and distinguish the device ID when downloading the 

attendance report. 

Select Setting on the Report interface. 
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12 Access Control 

On the Main Menu, tap Access Control to set the schedule of lock. 

 

 Access Control Options 12.1
Tap Access Control Options on the Access Control interface to set the parameters of the control lock of 

the terminal and related equipment. 

 

Function Description  

Function Name Description 

Door Lock Delay (s) 
The amount of time that the device controls the electric lock to be in unlock 
state. 

Valid value: 1~10 seconds; 0 seconds represents disabling the function. 

Door Sensor Delay (s) 
An alarm is triggered if the door is not closed within a defined time (Door Sensor 
Delay). 

The valid value of Door Sensor Delay ranges from 1 to 255 seconds. 

Door Sensor Type 

There are three Sensor types: None, Normal Open, and Normal Closed. 

None: It means the door sensor is not in use. 

Normal Open: The door is always open when electric power is on. 

Normal Closed: The door is always close when electric power is on. 
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13 USB Manager 

You can import the user information, work code, and attendance data in the device to match the 

attendance for processing by using a USB disk or import the user information and work code to other 

fingerprint devices for backup.  

NOTE: Before uploading/downloading data from/to the USB disk, insert the USB disk into the USB slot first. 

Tap USB Manager on the main menu interface.  

 

 Download 13.1
Tap Download on the USB Manager interface. 

 

Function Name Description 

Attendance Data To download attendance data in a specified time into a USB disk. 

User Data To download all user information from the device into a USB disk. 

User Portrait To download all user photos from the device into a USB disk. 

Attendance Photo To download all attendance photos from the device into a USB disk. 

Blocklist Photo 
To download all block listed photos (photos taken after failed verifications) from 
the device into a USB disk. 

Work Code To save the work code in the device to a USB disk. 
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 Upload 13.2
Tap Upload on the USB Manager interface. 

 

Function Name Description 

Screen Saver 

To upload all screen savers from USB disk into the device. You can choose 
Upload selected photo or Upload all photos. The images will be displayed 
on the device's main interface once uploaded. Create a folder named 
"advertise" in the root directory of the USB disk and put the advertising 
photos in this directory before uploading. 

Wallpaper 

To upload all wallpapers from USB disk into the device. You can choose 
Upload selected photo or Upload all photos. The images will be displayed 
on the screen once uploaded. Create a folder named "wallpaper" in the root 
directory of the USB disk and put the wallpaper photos in this directory 
before uploading. 

User Date To upload all the user information from the USB disk into the device. 

User Portrait To upload all user photos from a USB disk into the device. 

Upload Work Code To upload work code from a USB disk into the device. 

 Download Options  13.3
Tap Download Options on the USB Manager interface. 

 

Function Name Description 

Encrypt 
Attendance Date 

The attendance data is encrypted during the uploading and downloading. 

Delete ATT Data After successful downloading, the attendance data on the device is deleted. 



EFace10                                                                  User Manual 

P a g e  | 62   Copyright©2022 ZKTECO CO., LTD.  All rights reserved. 

14 Attendance Search 

Once the identity of a user is verified, the Attendance Record is saved in the device. This function enables 

users to check their access records. 

Click Attendance Search on the Main Menu interface to search for the required Attendance Record.  

 

The process of searching for attendance and blocklist photos is similar to that of searching for Attendance 

Record. The following is an example of searching for Attendance Record. 

On the Attendance Search interface, tap Attendance Record to search for the required record.  

1. Enter the user ID to be searched and click OK. 
For the records of all users, click OK without 
entering any user ID. 

2. Select the time range within which the logs need 
to be searched. 

  

3. Once the log search succeeds, tap the record 
highlighted in green to view its details. 

4. The below figure shows the details of the 
selected record. 
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15 Work Code 

Employees’ salaries are subject to their attendance records. An employee can be engaged in more than 

one type of work which may vary with time. As the pay varies according to the work types, the FFR 

terminal provides a parameter to indicate the corresponding work type for every attendance record to 

facilitate rapid understanding of different attendance situations during the handling of attendance data. 

On the Main Menu, tap Work Code to set the work code. 

 

 Add a Work Code 15.1

 

Function Description 

Function Name Description 

ID 
It is the digital code of the work code. Users may set a valid value between 1 and 
99999999. 

Name It is the naming of the work code. 
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 All Work Codes 15.2
You can view, edit and delete work codes in All Work Codes. The process of editing a work code is the 

same as adding a work code, except that the ID is not allowed to be modified.  

        

 Work Code Options 15.3
To set whether entering the work code is a must and whether the entered work code must exist during 

authentication. 

      

In 1: N or 1:1 verification, the system will automatically pop up the following window. Select the 

corresponding Word Code manually to verify successfully. 
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16 Autotest 

On the Main Menu, tap Autotest to automatically test whether all modules in the device function properly, 

including the LCD, Voice, Camera, and Real-Time Clock (RTC). 

 

Function Description 

Function Name Description 

Test All 
To automatically test whether the LCD, Audio, Camera and RTC are working 
normally. 

Test LCD 
To automatically test the display of the LCD screen by displaying all the color 
bands including pure white and pure black to check whether the screen displays 
the colors accurately. 

Test Voice 
To automatically test whether the audio files stored in the device are complete 
and the voice quality is good. 

Test Face 
To test if the camera functions properly it checks the photos taken and determines 
if they are clear enough. 

Test Clock RTC 
To test the RTC. The device checks whether the clock works normally and 
accurately with a stopwatch. Touch the screen to start counting and press it again 
to stop counting. 
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17 System Information 

On the Main Menu, tap System Info to view the storage status, the version information of the device, and 

firmware information. 

 

Function Description 

Function Name Description 

Device Capacity 
Displays the current device's user storage, password, face and card★ storage, 
administrators, attendance records, attendance and blocklist photos, and profile 
photos. 

Device Info 
Displays the device's name, serial number, MAC address, face algorithm, version 
information, platform information, manufacturer, and manufacture date. 

Firmware Info Displays the firmware version and other version information of the device. 

  



EFace10                                                                  User Manual 

P a g e  | 67   Copyright©2022 ZKTECO CO., LTD.  All rights reserved. 

18 Connect to ZKBioAccess IVS Software 

 Set the Communication Address 18.1
 Device side 

1. Tap COMM. > Ethernet in the main menu to set the IP address and gateway of the device. 

(Note: The IP address should be able to communicate with the ZKBioAccess IVS server, preferably 

in the same network segment with the server address)  

2. In the main menu, click COMM. > Cloud Server Setting to set the server address and server port.  

Server address: Set the IP address as of ZKBioAccess IVS server. 

Server port: Set the server port as of ZKBioAccess IVS(The default is 8881). 

  

 Software side 

Login to ZKBioAccess IVS software, click System > Communication > Communication Monitor to set the 

ADMS service port, as shown in the figure below: 

 

 Add Device on the Software 18.2
Add the device by searching. The process is as follows: 

1. Click Attendance > Attendance Device > Device > Search, to open the Search interface in the 

software. 
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2. Click Search, and it will prompt [Searching……]. 

3. After searching, the list and total number of access controllers will be displayed. 

 

4. Click [Add] in operation column, a new window will pop-up. Select Icon type, Area, and Add to 

Level from each dropdown and click [OK] to add the device. 

 Add Personnel on the Software 18.3
1. Click Personnel > Person > New: 

 

2. Fill in all the required fields and click [OK] to register a new user. 

3. Click Attendance > Attendance Device > Device > Control > Synchronize Software Data to 
the Devices to synchronize all the data to the device including the new users. 
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Appendix 1 

Self-Service Attendance Terminal FAQs 

1. Does self-service attendance terminal support scheduling based on every other day? 

A: No. 

2. Can the setting records downloaded from the device be edited on WPS software? 

A: Yes. Setting records are supported in Microsoft Office 2003, Microsoft Office 2007, and WPS Office 2012 

Personal.  

3. What is the attendance calculation flow adopted by the self-service attendance terminal? 

A: SSR attendance calculation flow. 
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4. How to calculate special overtime hours? 

The following cases are deemed special overtime: 

a) When an EXCEL schedule record exists and attendance reports are used for attendance calculation, 

there are check-in and check-out records though there is no schedule (or rest is arranged) for the 

current date.  

b) When no EXCEL schedule record is available, there are check-in and check-out records though 

Saturday and Sunday are non-working days.  

Overtime hours refer to the duration counted from the first check-in time to the last check-out time on the 

current day. 

5. How to arrange schedules using the attendance setting report? 

Step 1: Insert a USB flash drive into the USB port or SD card into the SD port of the device and download 

the Attendance Setting Report.xls to the USB flash drive or SD card.  

Step 2: Open the Attendance Setting Report.xls on a computer.  

Step 3: Set shifts in the Attendance Setting Report.xls as required. 

 

Step 4: Arrange schedules for employees.  

 

Note: Dates must be set correctly. For example, if the scheduling date is 2012-1-1, the schedule setting 

report contains the schedules of 31 days after 2012-1-1, that is, the schedule from 2012-1-1 to 2012-1-31. If 

the scheduling date is 2012-1-6, the schedule setting report contains schedules of 31 days after 2012-1-6, 

that is, the schedule from 2012-1-6 to 2012-2-5.  

Step 5: Insert a USB flash drive into the USB port or SD card into the SD port of the device and upload the 

Attendance Setting Report.xls to the device. Then, the schedules in the Attendance Setting Report can 

be used. 

 

Data enclosed by a red 
rectangle is new shifts 
(shift 3 and shift 4). To add 
a shift, enter a time 
directly, in the range of 
00:00 to 24:00.  

 

Holiday Leave On business Shifts 

Date 
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6. What is the correct time format used in the setting reports? 

A. The correct time format is shown in the following table. 

Shift No. 
First Time Range Second Time Range Overtime Range 

On-duty Off-duty On-duty Off-duty Check-in Check-out 

1 09:00 18:00     

2 09:00 12:00 13:30 18:00   

3 9:5 18:00     

B. Incorrect time formats are as follows: 

a) A time value is beyond the time range, such as 24:00. 

b) A time value contains Chinese characters, for example, 9:00, which differs from 9:00.  

c) A time value is preceded by a space. As shown in the following table, there is a space in front of 

09:00 in shift 1.  

Shift No. 
First Time Range Second Time Range Overtime Range 

On-duty Off-duty On-duty Off-duty Check-in Check-out 

1  09:00 18:00     

2 09:00 12:00 13:30 18:00   

3 9:5 18:00     

d) A time value contains special characters, for example, _9:00 and 09:-1.  

The device performs a validity check and error tolerance for other formats.  

7. How does the self-service attendance terminal collect the correct attendance time based on the 
preset shift time? 

A: The device collects attendance time based on the following principles: 

a) Adopt the earliest time for normal attendance and the nearest time for abnormal attendance. 

b) Adopt the normal attendance time if the normal attendance time and abnormal attendance time 

coexist. 

c) Adopt a median in the attendance time range.  
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B: The following uses four examples to describe the preceding principles.  

Example 1: Normal attendance 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 
employee 

8:30, 8:35, 11:55,12:01, 12:50, 18:02,19:00 

Statistical result based on 
attendance rules 

8:30 12:01 12:50 18:02   

Description: The attendance time 8:30 and 8:35 are earlier than the on-duty time 9:00 and they are within 

the normal attendance time range. Therefore, 8:30 is adopted for the on-duty time 9:00 based on the 

principle of adopting the earliest time for normal attendance. 18:02 and 19:00 are later than the off-duty 

time 18:00, and therefore, 18:02 is adopted based on the same principle.  

Example 2: Late arrival 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 
employee 

9:01, 9:04, 12:01, 12:50, 18:00 

Statistical result based on 
attendance rules 

9:01 12:01 12:50 18:00   

Description: Employer 1 checks in for work at 9:01 and 9:04 and he/she is late based on the preset on-duty 

time. Based on the principle of adopting the nearest time for abnormal attendance, the correct check-in 

time is 9:01 rather than 9:04 because of 9:01 is nearer 9:00. 

Example 3: Early leave 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 
employee 

8:50, 11:40,11:55, 12:50, 18:01 

Statistical result based on 
attendance rules 

8:50 11:55 12:50 18:01   

Description: The attendance time 12:50 is adopted based on the principle of adopting a median in the 

attendance time range. For the attendance time range from 9:00 to 12:00, the normal check-out time 

range for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 12:00 + (13:00 - 12:00)/2). Therefore, the 

calculated time of attendance is shown in the preceding table. 
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Example 4: Absence 

Case 1: 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 
employee 

8:50, 12:50, 18:01 

Statistical result based on 
attendance rules 

8:50  12:50 18:01   

Description: The attendance time 12:50 is adopted based on the principle of adopting a median in the 

attendance time range. For the attendance time range from 9:00 to 12:00, the normal check-out time 

range for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 12:00 + (13:00 - 12:00)/2). Therefore, the 

check-out time is blank. The normal check-in time range for the on-duty time from 13:00 is from 12:30 to 

13:00. The calculated time of attendance is shown in the preceding table.  

Case 2: 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00   

Attendance time of #1 
employee 

8:50, 11:55, 12:20, 18:01  

Statistical result based on 
attendance rules 

8:50 12:20  18:01    

Description: The time 12:20 is adopted based on the principle of adopting a median in the attendance 

time range. The normal check-out time range for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 

12:00 + (13:00 - 12:00)/2). Therefore, the check-out time of the employee is 12:20. The normal check-in 

time range for the on-duty time from 13:00 is from 12:30 to 13:00. Therefore, the check-in time of the 

employee is blank. The calculated time of attendance is shown in the preceding table. 
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Requirements of Live Collection and Registration of Visible Light Face 

Images 
1） It is recommended to perform registration in an indoor environment with an appropriate light 

source without underexposure or overexposure on the face. 

2） Do not place the device towards outdoor light sources like door or window or other harsh light 

sources. 

3） Dark-color apparels other than the background color is recommended for registration. 

4） Expose your face and forehead properly and do not cover your face and eyebrows with your hair. 

5） It is recommended to show a normal facial expression. (A smile is acceptable, but do not close your 

eyes, or incline your head to any orientation). 

6） Two images are required for a person with eyeglasses, one image with eyeglasses and the other 

without them. 

7） Do not wear accessories like a scarf or mask that may cover your mouth or chin. 

8） Please face right towards the capturing device and locate your face in the image capturing area as 

shown in the image below. 

9） Do not include more than one face in the capturing area. 

10） A distance of 50cm to 80cm is recommended for capturing the image (the distance is adjustable, 

subject to body height). 

 
Image1 Face Capture Area 
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Requirements for Visible Light Digital Face Image Data 
The digital photo should be straight-edged, colored, half-portrayed with only one person, and the person 

should be uncharted and in casuals. Persons who wear eyeglasses should remain to put on eyeglasses for 

getting photo captured. 

 Eye Distance 

200 pixels or above are recommended with no less than 115 pixels of distance. 

 Facial Expression 

A neutral face or smile with eyes naturally open are recommended. 

 Gesture and Angel 

The horizontal rotating angle should not exceed ±10°, elevation should not exceed ±10°, and depression 

angle should not exceed ±10°. 

 Accessories 

Masks or coloured eyeglasses are not allowed. The frame of the eyeglasses should not cover the eyes and 

should not reflect light. For persons with thick eyeglasses frames, it is recommended to capture two 

images, one with eyeglasses and the other one without them. 

 Face 

Complete face with clear contour, real scale, evenly distributed light, and no shadow. 

 Image Format 

Should be in BMP, JPG or JPEG. 

 Data Requirement 

Should comply with the following requirements: 

1） White background with dark-colored apparel. 

2） 24bit true color mode. 

3） JPG format compressed image with not more than 20kb size. 

4） Resolution should be between 441 x 358 to 1920 x 1080. 

5） The vertical scale of head and body should be in a ratio of 2:1. 

6） The photo should include the captured person’s shoulders at the same horizontal level. 

7） The captured person’s eyes should be open and with a clearly seen iris. 

8） A neutral face or smile is preferred, showing teeth is not preferred. 

9） The captured person should be easily visible, natural in color, no harsh shadow or light spot or 

reflection in the face or background. The contrast and lightness level should be appropriate. 
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Appendix 2 

Privacy Policy 
Notice: 

To help you better use the products and services of ZKTeco and its affiliates, hereinafter referred as "we", 

"our", or "us", the smart service provider, we consistently collect your personal information. Since we 

understand the importance of your personal information, we took your privacy sincerely and we have 

formulated this privacy policy to protect your personal information. We have listed the privacy policies 

below to precisely understand the data and privacy protection measures related to our smart products 

and services. 

Before using our products and services, please read carefully and understand all the rules and 
provisions of this Privacy Policy. If you do not agree to the relevant agreement or any of its terms, 
you must stop using our products and services. 

I. Collected Information 

To ensure the normal product operation and help the service improvement, we will collect the 

information voluntarily provided by you or provided as authorized by you during registration and 

use or generated as a result of your use of services. 

1. User Registration Information: At your first registration, the feature template (Fingerprint 
template/Face template/Palm template) will be saved on the device according to the 
device type you have selected to verify the unique similarity between you and the User ID 
you have registered. You can optionally enter your Name and Code. The above information is 
necessary for you to use our products. If you do not provide such information, you cannot use 
some features of the product regularly. 
 

2. Product information: According to the product model and your granted permission when 
you install and use our services, the related information of the product on which our services 
are used will be collected when the product is connected to the software, including the 
Product Model, Firmware Version Number, Product Serial Number, and Product Capacity 
Information. When you connect your product to the software, please carefully read the 
privacy policy for the specific software. 

II. Product Security and Management 

1. When you use our products for the first time, you shall set the Administrator privilege before 
performing specific operations. Otherwise, you will be frequently reminded to set the 
Administrator privilege when you enter the main menu interface. If you still do not set the 
Administrator privilege after receiving the system prompt, you should be aware of the 
possible security risk (for example, the data may be manually modified). 
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2. All the functions of displaying the biometric information are disabled in our products by 
default. You can choose Menu > System Settings to set whether to display the biometric 
information. If you enable these functions, we assume that you are aware of the personal 
privacy security risks specified in the privacy policy. 

 
3. Only your user ID is displayed by default. You can set whether to display other user 

verification information (such as Name, Department, Photo, etc.) under the Administrator 
privilege. If you choose to display such information, we assume that you are aware of 
the potential security risks (for example, your photo will be displayed on the device 
interface). 

 
4. The camera function is disabled in our products by default. If you want to enable this 

function to take pictures of yourself for attendance recording or take pictures of strangers for 
access control, the product will enable the prompt tone of the camera. Once you enable 
this function, we assume that you are aware of the potential security risks. 

 
5. All the data collected by our products is encrypted using the AES 256 algorithm. All the data 

uploaded by the Administrator to our products are automatically encrypted using the AES 
256 algorithm and stored securely. If the Administrator downloads data from our products, 
we assume that you need to process the data and you have known the potential security risk. 
In such a case, you shall take the responsibility for storing the data. You shall know that some 
data cannot be downloaded for sake of data security. 

 
6. All the personal information in our products can be queried, modified, or deleted. If you no 

longer use our products, please clear your personal data. 
 

III. How we handle personal information of minors 

Our products, website and services are mainly designed for adults. Without consent of parents or 

guardians, minors shall not create their own account. If you are a minor, it is recommended that you 

ask your parents or guardian to read this Policy carefully, and only use our services or information 

provided by us with consent of your parents or guardian. 

We will only use or disclose personal information of minors collected with their parents' or guardians' 

consent if and to the extent that such use or disclosure is permitted by law or we have obtained their 

parents' or guardians' explicit consent, and such use or disclosure is for the purpose of protecting 

minors.  

Upon noticing that we have collected personal information of minors without the prior consent from 

verifiable parents, we will delete such information as soon as possible. 
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IV. Others 

You can visit https://www.zkteco.com/cn/index/Index/privacy_protection.html to learn more about 

how we collect, use, and securely store your personal information. To keep pace with the rapid 

development of technology, adjustment of business operations, and to cope with customer needs, 

we will constantly deliberate and optimize our privacy protection measures and policies. Welcome 

to visit our official website at any time to learn our latest privacy policy. 
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Eco-friendly Operation 

The product's "eco-friendly operational period" refers to the time during which this 
product will not discharge any toxic or hazardous substances when used in accordance 
with the prerequisites in this manual. 

The eco-friendly operational period specified for this product does not include batteries or 
other components that are easily worn down and must be periodically replaced. The 
battery's eco-friendly operational period is 5 years. 

Hazardous or Toxic substances and their quantities 

Component 
Name 

Hazardous/Toxic Substance/Element 

Lead (Pb) 
Mercury 

(Hg) 
Cadmiu
m (Cd) 

Hexavalent 
chromium 

(Cr6+) 

Polybrominate
d Biphenyls 

(PBB) 

Polybrominated 
Diphenyl Ethers 

(PBDE) 

Chip Resistor × ○ ○ ○ ○ ○ 

Chip Capacitor × ○ ○ ○ ○ ○ 

Chip Inductor × ○ ○ ○ ○ ○ 

Diode × ○ ○ ○ ○ ○ 

ESD 
component 

× ○ ○ ○ ○ ○ 

Buzzer × ○ ○ ○ ○ ○ 

Adapter × ○ ○ ○ ○ ○ 

Screws ○ ○ ○ × ○ ○ 

○ indicates that the total amount of toxic content in all the homogeneous materials is below the

limit as specified in SJ/T 11363—2006.

× indicates that the total amount of toxic content in all the homogeneous materials exceeds the limit 
as specified in SJ/T 11363—2006. 

Note: 80% of this product’s components are manufactured using non-toxic and eco-friendly 
materials. The components which contain toxins or harmful elements are included due to the 
current economic or technical limitations which prevent their replacement with non-toxic materials 
or elements. 
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